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Lesson Learnt From 
SingHealth Data Breach
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How did the data breach occur?

The hackers behind the 
SingHealth cyber attack snuck 
in…nearly a year before 
stealing the data of 1.5 million 
patients…

The attacker gained a foothold 
through an unpatched front-
end computer at Singapore 
General Hospital, likely through 
a phishing email. 

05 OCTOBER, 2018

https://www.todayonline.com/singapore/malware-used-singhealth-cyber-attackers-uniquely-tailored-had-not-been-observed-
elsewhere
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How did the data breach occur?

“The attacker was able to gain access to an end-user workstation via a 
publicly available hacking tool because the workstation was running on a 
version of Microsoft Outlook that was not patched to address the use 
of that hacking tool,”…

21 SEPTERMBER, 2018

https://www.channelnewsasia.com/news/singapore/singhealth-cyberattack-committee-inquiry-staff-hack-10744182
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Factors Leading to the Data Breach
@ Front End Computer

NUS Restricted

2 Front end workstation was running vulnerable version of Outlook

1 User fall prey to Phishing email

https://www.channelnewsasia.com/news/singapore/customised-uniquely-tailored-malware-singhealth-cyberattack-10794852
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Averting the Data Breach
- Apply Security Best Practices

2 Keep software updated

1 Keep operating system updated

4 Stay vigilant, don’t click on suspicious email and report it 

3 Disable Windows PowerShell (tool for system administrator) 
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Keep Window OS Updated

NUS Restricted

Settings-> Update and Security->Check for updates
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Install University Anti Virus Software
from Software Centre
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Trend Micro Office Scan Client Status
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https://docs.trendmicro.com/all/ent/officescan/v10.6/en-us/osce_10.6_sp1_olh/c_s_connect_icons.html

×√
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Disable PowerShell (1/2) 
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Open Control Panel > Program and Features >Turn Window 
Features on or Off

Windows PowerShell is a task-based command-line shell and scripting language 
designed especially for system administration. PowerShell can be exploited by 
attackers to execute malicious commands and scripts. Consider disabling PowerShell 
if it is not required by standard user workstations.

https://www.csa.gov.sg/singcert/news/advisories-alerts/measures-for-protecting-customers-personal-data
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Disable PowerShell (2/2) 
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Uncheck Windows PowerShell 2.0 and click Ok

https://www.csa.gov.sg/singcert/news/advisories-alerts/measures-for-protecting-customers-personal-data
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Enable Data Execution Prevention (1/3)
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Open Control Panel > System > Advance System Settings 

Note: This ensures program are not run on unauthorized memory area
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Enable Data Execution Prevention (2/3)
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Open System Properties> Advance > Performance > Settings

Note: This ensures program are not run on unauthorized memory area
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Enable Data Execution Prevention (3/3)
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Open Performance Options > Data 
Execution Prevention 

Select the option, “Turn on DEP for all 
programs and services except those I 
select” . Leave the selection list empty 
and click on OK. 
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Answer: 
Report suspicious email using Phishing Reporter Button or
Email to ITCARE@nus.edu.sg
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Answer: 
• Report phishing using Phishing reporter button
• Inform ITCARE if your account has assess to sensitive 

information or system
• Change password from another machine
• Scan machine with university licensed anti-virus
• Format the machine maybe required in some cases
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Answer: 
For example:
• Your computer’s local account passwords have been changed 
• You see new User Accounts added (lusrmgr.msc)
• Your friends are reporting strange or spam emails from you
• You find new programs or toolbars installed on your computer
• Your security or anti-virus software has been disabled
• Your Internet searches or home page are redirected
https://www.thewindowsclub.com/how-do-i-know-if-computer-hacked/
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How did the data breach occur?

https://www.channelnewsasia.com/news/singapore/customised-uniquely-tailored-malware-singhealth-cyberattack-
10794852
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Factors leading to the data breach
@ Front End Computer

NUS Restricted

2 Privilege Escalation from standard to system/admin account. 
E.g.

1 Lateral movement to other machines. 
E.g. 

• Share Folders
• Remote Desktop Protocol (e.g. RDP)
• Remote Services (e.g. VNC, Telnet, SSH)

• Missing patches
• Weak folder permissions settings
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Averting the Data Breach
- Apply Security Best Practices

2 Disable Remote Desktop Connections

1 Remove open share folders.

https://www.ricksdailytips.com/disable-remote-assistance/

https://www.lifewire.com/disable-windows-remote-desktop-153337/

3 Disable Remote Assistance

4 Use standard account
https://www.windowscentral.com/how-change-user-account-type-windows-10

https://nusit.nus.edu.sg/its/resources/tips-to-check-and-remove-insecure-shared-folder-in-windows-pc/
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Answer: 
Folders with content can be read, update and delete by everyone.
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What is Open Shares
This a user misconfiguration where 
shared folder permission is set to allow 
EVERYONE to have full access. It 
provides a very easy and effective way 
for attackers to browse and steal the 
(sensitive) data without any hacking tool 
or skill. 

What should I DO
You should do a self-check on your 
computer to discover if there is any 
Open Shares or folder that has been 
shared unintentionally, and remove 
it immediately. 

What is Open Share Folder?
https://nusit.nus.edu.sg/its/resources/tips-to-check-and-remove-insecure-shared-folder-in-windows-pc/
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Remove Insecure Share Folders
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Share to only authorized party 
and not everyone

1

2

3

https://nusit.nus.edu.sg/its/resources/tips-to-check-and-remove-insecure-shared-folder-in-windows-pc//
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Disable Deprecated 
File Sharing Protocol (SMB v1)

NUS Restricted

Open Control Panel > Programs & Features > Turn Windows features on or off.
Make sure it is unchecked. Restart your computer.

Note: This is an obsolete components for enabling shared access to files and printers and should be 
disabled.
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Turn off Network Discovery,
File and Printer Sharing
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Note: This state disallows your computer to see other network computers and devices and 
disallows people on other network computers to see your computer. 

Open Control Panel > Network and Internet >Network and Sharing Centre
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Remote Access Scam (Attack Techniques)

NUS Restricted

Scammers initiate contact by 
displaying fake error messages on 
websites you visit, displaying 
support numbers and enticing you 
to call. 

Remote access scams prey on 
peoples’ fear, greed or lack of 
technological understanding to 
impair their judgement, making 
them more likely to commit the 
grave error of giving a scammer 
access to their device.

https://support.microsoft.com/en-sg/help/4013405/windows-protect-from-tech-support-scams
https://www.nextadvisor.com/blog/how-to-avoid-and-recover-from-remote-access-scams/
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Disable Remote Assistance
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Control Panel->system->Remote Settings

Note: This state disallows someone else to temporarily take control of your PC 
over the Internet in order to fix a problem for you.
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Turn off Remote Desktop Connection to your PC
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Note: This state disallows remote access to your computer. 

Control Panel->System and Security->System->Remote Settings
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Six Essential 
Cyber Defence Measures by CSA
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https://www.csa.gov.sg/~/media/csa/documents/publications/be_safe_online/be_safe_online_handbook.pdf

Administrator privileges allow user to do many things such as install software and add new 
user. Restrict administrator privileges to authorised individuals. 



Copyright © NUS 2017

NUS Internal

Use Standard Account

NUS Restricted

Control Panel->Change Account Type->Properties

Note: Users with this type of account can run applications, but they can't install new programs. If a task requires 
elevations an username and password for an administrator will be needed 
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How did the data breach occur?

https://www.straitstimes.com/singapore/tardy-responses-security-failings-led-to-singhealth-breach

Solicitor-General cites weak 
password, lack of awareness 
of how critical the situation was

…one administrator account for 
the healthcare group's server 
…had the password, 
P@ssw0rd, and was breached 
easily, …

SEP 22, 2018
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How did the data breach occur?

https://www.channelnewsasia.com/news/singapore/customised-uniquely-tailored-malware-singhealth-cyberattack-
10794852
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How did the data breach occur?

https://www.channelnewsasia.com/news/singapore/coi-on-singhealth-cyberattack-exploited-server-had-not-been-10764472

…the server did in fact have 
an older version of an 
antivirus software 
installed

He added that he was not 
proficient in managing the 
security aspects of 
servers…

Mr Tan had been given the 
password for the server’s 
local administrator account, 
in case his help was 
needed.

SEP 27, 2018
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How did the data breach occur?

https://www.businesstimes.com.sg/government-economy/attack-on-singhealth-network-traced-back-to-aug-2017-coi-hearing

…the attacker exploited an inactive administrator account 
to remotely log into a server containing the EMR records. The 
server should have been decommissioned but was not.

SEP 21, 2018
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Factors leading to the data breach
@ Servers

NUS Restricted

1 Local Administrator account has weak Password (P@ssw0rd)

2 Server had outdated window patches (~14 months)

4 System administrator was not trained

3 Server had outdated anti-virus (older version)

5 System administrator account was no longer required

6 Server should have been decommissioned but was not 



Copyright © NUS 2017

NUS Internal

Averting the Data Breach
- Apply Security Best Practices

NUS Restricted

1 Use strong password and 2FA for administrator account
Email to ITCARE@nus.edu.sg for more information. Refer IT Security Policy Chp. 4 Clause 6.3.2.

2

Get NUS IT anti-virus agent install on your server
Email to ITCARE@nus.edu.sg for more information

5 Monitor administrator or privileges account activities. Remove 
account that is no longer required Refer IT Security Policy Chp. 4 Clause 4.3.4.

3

Refer NUS IT hardening guidelines for securing your server
https://nusit.nus.edu.sg/its/wp-login.php?redirect_to=/its/policies/nus-it-security-policy

4

Engage NUS IT to manage your server (includes patch mgtm svc) 
Email to ITCARE@nus.edu.sg for more information

6 Decommission system that is no longer required. 
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Answer: Minimum of twelve (12) characters in length;  and 
comprised of letters, numbers, and special characters
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Decommission System Checklist
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1 Decommission your server
Select Virtual Machine - Delete

3 Decommission your domain name
Hostname registration

2 Decommission your IP address
Firewall request – Modify/Delete

https://ntouch.nus.edu.sg/ux/myitapp/#/catalog/home 
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How did the data breach occur?

https://www.channelnewsasia.com/news/singapore/customised-uniquely-tailored-malware-singhealth-cyberattack-
10794852
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How did the data breach occur?

The Allscripts SCM software was mentioned as there is 
evidence there was “insecure coding vulnerability” in it 
and it is “highly probable” the vulnerability allowed the 
attacker to easily retrieve SCM database credentials from 
the Citrix server on H-Cloud, which can then be used to log in 
to the database.

https://www.channelnewsasia.com/news/singapore/singhealth-cyberattack-committee-inquiry-staff-hack-10744182 SEP 21, 2018
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Averting the Data Breach
- Apply Security Best Practices

NUS Restricted

1 Get your website application scan for vulnerability before 
and upon commission or when there are major changes
Email to CCECERT@nus.edu.sg for more information

2 Fix these website application vulnerability on timely basis
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How did the data breach occur?

https://www.straitstimes.com/singapore/tardy-responses-security-failings-led-to-singhealth-breach

Solicitor-General cites weak 
password, lack of awareness 
of how critical the situation
was

SEP 22, 2018

Although IHiS staff detected unauthorised failed attempts to access 
SingHealth's critical systems as early as June 11 this year, they did not alert 
IHiS senior management until the night of July 9.

No training or briefing was provided to me or my team on the IHiS Sirf
(Security Incident Reporting Framework)
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How did the data breach occur?

https://www.straitstimes.com/singapore/team-would-have-no-day-no-night-if-i-raised-alert-exec

NOV 1, 2018

It was his job to sound the alarm on suspicious cyber activities in 
Singapore's biggest health network - but …decided not to, even 
though the warning signs were there.

The reason for his reluctance: It would lead to more work for him and 
his team and pressure from his bosses, …claim that he and his team 
members would have "no day, no night".



Copyright © NUS 2017

NUS Internal

Averting the Data Breach
- Apply Security Best Practices

NUS Restricted

1 Report suspicious activities or incidents immediately 
Email to CCECERT@nus.edu.sg for more information

2 Keep management inform on security events and incidents 
Email to CCECERT@nus.edu.sg for more information

3 Be aware of what is an incident and how to report one
Email to CCECERT@nus.edu.sg for more information
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Identify and Report 
Security Incidents

Security is 
lifestyle!

Think Safe. 
Think Secure.
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Examples of Security  Incidents
Relating to Staff/Students

NUS Restricted

1 Unauthorized use of your accounts 
(e.g. emails access or sent without your knowledge).

2 Receive or Fell prey to Phishing or suspicious emails 
(e.g. you received or responded to email requesting 
for your account information).

3 Lost or stolen mobile devices or portable storage 
containing University data (especially if it contains 
personal data)
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Answer: Yes
https://www.howtogeek.com/99423/email-whats-the-difference-in-pop3-imap-and-exchange/
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Examples of Security  Incidents
Relating to Staff/Students

NUS Restricted

4 Incorrectly sent email which contains NUS 
confidential or personal data.

5 NUS confidential or personal data exposed on 
public website.

6 Knowledge or discovery of any vulnerabilities in 
NUS systems or applications
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The commission found that a URL link 
for a Google Sheets spreadsheet, 
started by students from NUS College 
of Alice and Peter Tan, had disclosed 
personal data of students without 
authorization.

It contained the full names, mobile 
numbers, matriculation numbers, shirt 
sizes, dietary preferences, dates of 
birth, dormitory room numbers and 
email addresses of the student 
volunteers …

https://www.straitstimes.com/singapore/143-nus-student-volunteers-data-breached-school-directed-to-provide-
mandatory-training APR 28, 2017
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The "software bug" surfaced 
after changes were made to 
the Singapore carrier's 
website on January 4 and 
enabled some of its Krisflyer
members to view information 
belonging to other travellers, 
SIA told ZDNet in an email.

https://www.zdnet.com/article/singapore-airlines-data-breach-affects-284-accounts-exposes-travel-details/

JAN 5, 2019
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Examples of Security  Incidents
Relating to System Administrators
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1 Unauthorized logins to system, including successful and 
persistent failed logins.

2 Unauthorized use of system for processing or storing of data 
(e.g. upload unintended files to website).

3 Changes to system without instruction, or consent, say evident 
changes on system hardware, firmware, or software functionality, 
configuration, logs or data (e.g. web page defacement).

4 Unwanted disruption of service 
(e.g. unusually high volume of request for e-services).
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How to Report Security Incident?
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1 How and When did the incident occur?

2 Who reported the incident?

3 How was the incident discovered? 

4 What were the targeted systems or accounts details? 
e.g. userID, ip address, MAC address, URL

5 Was there any data loss or leakage? If so, please elaborate the 
data classification and description.

6 Was there any follow up actions taken and possible impacts to 
the university?
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How to Report Security Incident?
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1 Email to NUS IT CARE at itcare@nus.edu.sg

2 Contact NUS IT CARE at 6516-2080. 

3 Use online security incident reporting form
https://nusit.nus.edu.sg/its/cceforms/i-want-to/report-an-incident/ 

4 Email to CCECERT@nus.edu.sg

For unauthorized used of email and phishing related incidents  

For any other system related incidents 
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Cyber Attacks Techniques: 
Phishing, Smishing, Vishing, USB 

Drop Attack & Malware
Network

Servers

Applications
Clients (Users)
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Email sent by attackers, often using spoofed email account, 

Or pretending to be someone you know with  aim to:

 Steal your user credentials so that they can gain access to your
device and network.

 Entice you to click on links that take you to web sites that will
infect your computer with malware just by visiting it.

 Open attachments that can infect your computer with
malware.

What is Phishing Email?
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Sample Phishing Email Reported By Staff 

https://nusit.nus.edu.sg/its/resources/scenariophishing-drill/phish-bowl/
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Answer: Yes
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Sample Phishing Email Reported By Staff 

https://nusit.nus.edu.sg/its/resources/scenariophishing-drill/phish-bowl/

We have received your letter headed authorization to
process pending payment to another bank….
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Attackers can utilize

 Phishing: Email

 Smishing: SMS, WhatsApp, Social Media

 Vishing: Phone Calls

 Others: USB

Cyber Attackers Vectors
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“Phishing” via SMS (Smishing)
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https://www.businessinsider.sg/singhealth-fake-sms-messages-verify/

To verify the message, 
SingHealth said that its 
name will be reflected as 
the sender, and that it will 
not require credit card or 
other financial information: 
“Check that the SMS is 
from ‘SingHealth’ and that 
when you ‘click’, it brings 
you to the SingHealth
website.”
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“Phishing” via Phone Calls (Vishing) 
with modified Caller ID
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Singapore Airlines warns of phishing scams offering free air 
tickets

https://www.channelnewsasia.com/news/singapore/singapore-airlines-warns-of-
phishing-scams-offering-free-air-9513474

Beware of emails, calls, 
messages, surveys and 
contests that claim to be 
from Singapore Airlines (SIA) 
and which offer free air 
tickets or credits, said the 
flag carrier on Wednesday 
(Dec 20).

Published Dec 20, 2017

To appear more authentic, some scammers modify their caller ID to imitate 
SIA's official telephone numbers. … The airline also advised customers to be 
on the alert for phishing websites that appear similar to the official 
SIA website, and to exercise caution in sharing their personal details online.
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Attackers can:

 Spoof Email and Phone Numbers

 Fake News and Website.

 Use Familiar Email Subject

 Adopt Emotive such as greed, curiosity, anxiety, fear, etc

Attackers Techniques
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Phishing email getting more sophisticated

Source: https://www.todayonline.com/singapore/dbs-warns-phishing-site-targeting-bank-customers
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How to Identify Spoofed Email?
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How to Identify Spoofed Email?
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1 Look out for ”Sender Not Verified” in the subject

2 Look out for digital signature

3 Type the email address at the “to” field and click 
on check names

How to Identify Spoofed Email?



Copyright © NUS 2017

NUS Internal
NUS Restricted

Answer:
Yes, the account could be compromised. Report any suspicious 
email using Phishing reporter button. 
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Phishing Email from Legitimate Account & Familiar Subject
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https://www.wordfence.com/blog/2017/01/gmail-phishing-data-uri/

…. “The attackers log in to 
your account immediately 
once they get the credentials, 
and they use one of your 
actual attachments, along with 
one of your actual subject 
lines, and send it to people in 
your contact list
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Look Out for Scam Emails
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https://www.virustotal.com/
How to identify fake or malicious website?
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https://www.phishtank.com/

How to identify fake or malicious website?
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https://safeweb.norton.com/

How to identify fake or malicious website?
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https://transparencyreport.google.com/safe-browsing/search
How to identify fake or malicious website?
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1

2 Mouse over the the URL. Is it familiar?  e.g. NUS domain (nus.edu.sg) 

How to Identify Fake or Malicious Website?

Enter the known website directly from your browser

3 Use online scanner or link checker to verify if a website is malicious such as 
https://www.virustotal.com, https://www.phishtank.com/, etc
. 

e.g. organization

e.g. industry or country
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How to identify fake or malicious website?

Source: http://osxdaily.com/2014/02/20/preview-link-url-safari-ios/
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Answer: Check out haveibeenpwned.com or pastebin.com
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You can try key your email account over here

https://haveibeenpwned.com/
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Answer: Reset password. Run anti-virus scan.



Copyright © NUS 2017

NUS Internal
NUS Restricted

Answer: No, attacker may reuse same password to 
compromise your other account. 
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Source: https://venturebeat.com/2016/06/05/mark-zuckerbergs-twitter-and-pinterests-accounts-hacked-linkedin-password-
dump-likely-to-blame/
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Best Practices: Account & Password
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Use different account and password for social media and work.

1 Use strong password: minimum of twelve (12) characters in length and 
be comprised of letters, numbers, and/or special characters. 

2 Enable Two-Factor Authentication

3

Don’t remember password in web browser.4
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Edge          Browser  Settings
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SN Settings Values

1 Password and Form Data Do not remember passwords and form data

2 Cookies Don’t allow third party cookies

3 Pop up blockers Block pop up (that often comes from advertisement)

https://privacy.microsoft.com/en-gb/windows-10-microsoft-edge-and-privacy
https://www.macworld.com/article/3106793/security/disable-third-party-cookies-as-a-hedge-against-a-new-browser-based-attack.html

1 2 3
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What are the Sources of Malware?
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“Removable drives, flash memory 
devices, and network folders are 
commonly used for data 
transfer. When you run a file from a 
removable media you can infect your 
computer and spread the virus to the 
drives of your machine.”
~ kaspersky

Email Internet

“Software vulnerabilities are most 
common targets of hacker attacks. 
Vulnerabilities, bugs and glitches of 
software grant hackers remote access to 
your computer, and, correspondingly, to 
your data, local network resources, and 
other sources of information” ~ 
kaspersky

Source: https://www.csa.gov.sg/singcert/news/advisories-alerts/ransomware, https://support.kaspersky.com/viruses
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Some Malware can Traverse across Network
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Source: https://www.csa.gov.sg/singcert/news/advisories-alerts/ransomware
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Source: UC Santa Cruz Information Techology Services@ Sep 2015
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…Beware of Infected USB
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Prevent USB from being auto run on 
your laptop
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Source: https://www.techrepublic.com/article/how-to-disable-autoplay-and-autorun-in-windows-10/
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…Beware of Fake Apps
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https://www.csa.gov.sg/singcert/news/advisories-alerts/fake-mobile-apps
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…Beware of Vulnerable Apps

NUS Restricted

http://thehackernews.com/2017/09/ccleaner-hacked-malware.html

…is a popular application with over 2 billion 
downloads, created by Piriform and 
recently acquired by Avast, that allows 
users to clean up their system to optimize 
and enhance performance

Affected users are strongly recommended 
to update their CCleaner software to 
version 5.34 or higher, in order to protect 
their computers from being compromised

Avast and Piriform have both confirmed 
that the Windows 32-bit version of 
CCleaner v5.33.6162 and CCleaner Cloud 
v1.07.3191 were affected by the malware.
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Read Advisories

NUS Restricted

1 https://nusit.nus.edu.sg/its/

2

https://www.scamalert.sg/

3 https://www.csa.gov.sg/singcert/news/advisories-alerts

http://www.straitstimes.com/tags/cyber-security

4
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Data Protection Measures

Security is 
lifestyle!

Think Safe. 
Think Secure.
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Data 
Lifecycle

Create

Store

Use

Share

Backup

Dispose

Data Lifecycle & 
Data Protection Best Practices

Classify data as 
NUS-Internal, 
NUS-Restricted or 
NUS-Confidential.
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“Classify university 
data based on its 
sensitivity and impact 
to the university in 
terms of reputation, 
finance and operation 
should there be data 
breach”  

Public

Internal

Restricted

confidential

How Do I  Classify Data?
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Data Classification Examples

NUS 
Confidential

• Personal Data (i.e. Name, NRIC/FIN, DOB, Contact 
Details)

• Staff salary, staff appraisal
• Examination marks/grades & examination questions
• Financial data (e.g. Credit card / bank account numbers)
• Admission data (e.g. race, religion)
• Medical records
• Donor records

NUS Restricted

• Academic details of student (e.g. course info)
• Employment details (e.g. position hired for)
• Management reports
• Information covered by confidentiality obligation (e.g. 

contracts)

NUS Internal
• Staff circulars
• Internal policies
• Operating procedures

Public
• Publicly posted press releases/statistics
• University maps
• Newsletters, newspapers, magazines

Data Classification Examples
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“All university data shall be classified …” – Data 
Management Policy version 2.4 Sep 2018, 
Clause 3.1.1  

NUS Confidential Data includes 
personal data such as name, 
NRIC/Passport/FIN number, personal 
email and contact number, photograph, 
fingerprint, video/voice recording, medical 
record, etc

Data Management Policy Sep 2018
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Answer: For example, Label document header and/or footer with 
NUS Confidential, NUS Restricted and NUS Internal
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How do we classify data?

Classify data: 
e.g. Label the 
document 
header and 
footer with 
appropriate 
data 
classification

NUS Confidential

NUS Confidential

e.g. Tan Ah Kou
S7712345B
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Data Lifecycle & 
Data Protection Best Practices

Encrypt NUS-Confidential data
store on Laptop using 
Encrypting File System (EFS) 

Data 
Lifecycle

Create

Store

Use

Share

Backup

Dispose
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NUS Internal

Data Encryption & Decryption

Source: https://www.quora.com/What-are-encryption-and-decryption

00113 3
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Sony’s Data Leakage

Source : 
https://www.riskbasedsecurity.com/2014/12/a-breakdown-and-analysis-of-the-december-2014-sony-hack/
https://www.entrepreneur.com/article/240517
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Answer: Encrypt the data
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Enable EFS

https://nusit.nus.edu.sg/its/resources/encrypt-windows-folders/encrypt-windows-folders-and-contents/
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Enable EFS

https://nusit.nus.edu.sg/its/resources/encrypt-windows-folders/encrypt-windows-folders-and-contents/
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Enable EFS

https://nusit.nus.edu.sg/its/resources/encrypt-windows-folders/encrypt-windows-folders-and-contents/
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Back up  EFS Key
 Type certmgr.msc in the Search box and hit the ENTER key.
 Select Personal Folder and Click Certificates. Select userID.

https://nusit.nus.edu.sg/its/resources/encrypt-windows-folders/
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Back up  EFS Key
 Click Action -> All Tasks -> Export.
 Click Next on Certification Export Wizard 

https://nusit.nus.edu.sg/its/resources/encrypt-windows-folders/
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Back up EFS Key
 Select “Yes, export the private key”
 Click Next on Certification Export Wizard 

https://nusit.nus.edu.sg/its/resources/encrypt-windows-folders/
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Back up EFS Key
 Select Password option and Enter Password. Click Next on Certification Export Wizard.
 Click on Browse button, select the folder and enter filename for the EFS Key.

https://nusit.nus.edu.sg/its/resources/encrypt-windows-folders/
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Back up EFS Key
 Click Finish on Certification Export Wizard.

https://nusit.nus.edu.sg/its/resources/encrypt-windows-folders/backup-of-encryption-certificate-and-private-keys-for-windows-vista-7/
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Back up  EFS Key

 Always copy EFS key to another device such as USB.
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Answer: Data cannot be decrypted.



Copyright © NUS 2017

NUS Internal
NUS Restricted

Data Lifecycle & 
Data Protection Best Practices

Access data securely:
• Use VPN to access NUS system 

and data
• Use https website
• …

Data 
Lifecycle

Create

Store

Use

Share

Backup

Dispose
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Use VPN to access 
NUS System & Data off Campus

NUS Restricted

VPN -https://comcen.nus.edu.sg/qat4/wp-content/uploads/downloads/nvpn/nVPN-config-guide-for-staff.pdf

1

2

3

4
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Use https website

NUS Restricted

Source: https://blog.easynews.com/http-vs-https-whats-the-difference/
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Do not store password in browser

NUS Restricted

Source: https://www.pandasecurity.com/mediacenter/security/browser-saves-
password-secure/
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Answer: No, you might received unsolicited emails from mailing 
group or unknown sender when you use  NUS email account for 
subscribing to social media website. 
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What are the Best Practices ?

NUS Restricted

2

Log off from browser application after using it.3

Use https website for sensitive transactions 
(e.g. requires login)

1 Use VPN to access NUS System and data off 
campus.
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Source: Straits Times, @ Jan 2018
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Data Lifecycle & 
Data Protection Best Practices

Share data securely: Exchanging dataover email, portable storage, 
shared folders

Data 
Lifecycle

Create

Store

Use

Share

Backup

Dispose
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Sending Out Personal Data by Mistake 

NUS Restricted

Source (Mar 1, 2017):  http://www.straitstimes.com/singapore/take-steps-to-secure-online-accounts-experts-urge
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Encrypt Email with RMS
(Internal Users)

NUS Restricted

https://nusit.nus.edu.sg/its/resources/encrypt-email-withwithout-attachments/
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Encrypt Files with RMS
(Internal Users)

NUS Restricted

https://nusit.nus.edu.sg/its/resources/encrypt-email-withwithout-attachments/
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Encrypt Files with RMS
(Internal Users)

NUS Restricted

https://nusit.nus.edu.sg/its/resources/encrypt-email-withwithout-attachments/
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Encrypt Files with Password 
using Winzip

NUS Restricted
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Encrypt Files with Password 
using Winzip

NUS Restricted

Configure your Winzip encryption settings to AES 256
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Deferment of Email Delivery

NUS Restricted

From outlook client, go to File->Rules and Alerts->New Rule
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Deferment of Email Delivery

NUS Restricted

Select the option, “Apply rule on message I 
send”. Click the button, “Next”

Select the option, “Apply on this computer 
only”. Click the button, “Next”
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Deferment of Email Delivery

NUS Restricted

Select the option, “Defer delivery by a number of minutes”. Click on the hyperlink, “ a number of” and 
specify the number of minutes to delay. Click the button, “Finish”
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Answer: Use Nbox, Sharepoint
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Answer: Yes, use Bitlocker. 
Refer to Guideline for Use, Classification and Protection of Data, 
Section D, Table 2.
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Enable Bit Locker

NUS Restricted

Source: https://nusit.nus.edu.sg/its/resources/bitlocker/install-bitlocker/
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Data Lifecycle & 
Data Protection Best Practices

Save important 
data from your 
computer to other 
device

Data 
Lifecycle

Create

Store

Use

Share

Backup

Dispose
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https://nusit.nus.edu.sg/services/online_storage/nbox/
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Data Lifecycle & 
Data Protection Best Practices

Erase data 
securely

Data 
Lifecycle

Create

Store

Use

Share

Backup

Dispose
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https://inetapps.nus.edu.sg/comcen/security/protect-data/secure-hard-disk-disposal-using-blancco.html

Secure Disposal of Hard Disk using Blancco Drive Eraser

It is mandatory to erase and destroy all University data 
stored in the storage media before disposal. For 
redeployment of hard disk, use Blancco for secure 
erasure. For disposal of any functional or non-functional 
hard disk that the data cannot be erased by Blancco, 
physical destruction would be required; shred/incinerate 
Solid State Drive (SSD) and degauss Hard Disk Drive 
(HDD).

NUS IT Co-op offers these services. You may contact them 
at 67792942 or email at coppc05@nus.edu.sg.
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Dispose Data Securely

NUS Restricted

Paper containing personal 
information must be shredded 
into small pieces and not 
dumped in unsecured bins.

Similarly, personal data 
stored on electronic media 
such as computer hard disks, 
USB drives or DVDs must be 
erased using specialised 
software to avoid accidental 
data leaks

Source: Straits Times 21 Jul 2016
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Answer: 
Report immediately your supervisor and to cceda@nus.edu.sg
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Thank you! Every question you 
asked contributes to the FAQ list 

that we are building for NUS 
community.
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Information Security Policies
FAQ

Think Good practice
Implement Good practice
Protect our Data and System
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Answer: No, with AUP version 4.2 dated 1 Feb 2018, all 
Executive and Professional staff, Non-Academic staff 
and Senior Academic staff shall only use their 
University Assigned Email Accounts for official 
correspondence.
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Answer: No, you are liable for all actions performed 
using the account. AUP Clause 5.1.
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In the incident, which took 
place on Dec 26, 2015, an 
unknown perpetrator used 
valid admin account 
credentials to log in to a 
server that held personal 
customer data.

It found that Orchard Turn Developments did not have any policy 
to prohibit the sharing of admin account credentials, or to 
enforce the periodic expiry and renewal of these. Instead, it had 
only one admin account, which was shared among four 
authorised users. Source: CNA @ Jul 2017
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Answer: Most shareware are free for personal use and 
not for commercial use. For example, malwarebyte and 
Ccleaner. Read the terms and conditions to verify.
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Software Audit Circular dated 20thOct2016
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Department Software License Report
https://staffportal.nus.edu.sg/staffportal/it/software/software.html#5

Clause 3.1 Faculty Deans and Heads of Departments (HODs) are 
responsible for ensuring that all software used within the faculty or 
department and stored on computers in the faculty or department have 
been properly obtained and are being used within the terms of the software 
license. 
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Answer: 
Contact NUS IT Cloud Policy@nus.edu.sg.
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Answer: IT Security Policy Chap 1 Clause 3.4.1
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Answer: Yes, IT Security Policy Chap 1 Clause 3.6.3


